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1. Read Instructions - All the safety and operating instructions should be 
read before this product is operated. 

2. Retain Instructions - The safety and operating instructions should be 
retained for future reference. 

3. Heed Warnings - All warnings on the appliance and in the operating 
instructions should be adhered to. 

4. Follow Instructions - All operating and use instructions should be followed. 

5. Water and Moisture - The appliance should not be used near water - 
for example, near a bathtub, washbowl, kitchen sink, laundry tub, in a 
wet basement, or near a swimming pool, and the like. 

6. Heat - Appliance should be situated away from heat sources such as 
radiators, heat registers, stoves, or other appliances (including 
amplifiers) that produce heat. 

7. Power Sources - This product should be operated only from the type of 
power source indicated on the rating label. If you are not sure of the 
type of power supply to your home, consult your product dealer or local 
power company. For products intended to operate from battery power, 
or other sources, refer the operating instructions. 

8. Grounding or Polarization - This product may be equipped with a 
polarized alternating current line plug (a plug having one blade wider 
than the other). This plug will fit into the power outlet only one way. This 
is a safety feature. If you are unable to insert the plug fully into the outlet, 
try reversing the plug. If the plug should still fail to fit, contact your 
electrician to replace your obsolete outlet. Do not defeat the safety 
purpose of the polarized plug. 

9. Power-Cord Protection - Power-supply cords should be routed so that 
they are not likely to be walked on or pinched by items placed upon or 
against them, paying particular attention to the cord in areas adjacent 
to plugs, convenience receptacles, and the point where they exit from 
the appliance. 

10. Cleaning - The appliance should be cleaned only as recommended by the 
manufacturer. Clean only with a dry cloth. 

11. Non-use Periods - The power cord of the appliance should be 
unplugged from the outlet when left unused for a long period. 

12. The apparatus shall not be exposed to dripping or splashing and that 
no objects filled with liquids, such as vases, shall be placed on 
apparatus. 

 L'appareil ne doit pas être exposé aux écoulements ou aux 
éclaboussures et aucun objet ne contenant de liquide, tel qu'un vase, 
ne doit être placé sur l'objet. 

13. Main plug is used as disconnect device and it should remain readily 
operable during intended use. In order to disconnect the apparatus 
from the mains completely, the mains plug should be disconnected 
from the mains socket outlet completely. 

 La prise du secteur ne doit pas être obstruée ou doit être accessible 
pendant son utilisation. Pour être complètement déconnecté de 
l'alimentation d'entrée, la prise doit être débranchée du secteur. 

14. Damage Requiring Service - The appliance should be serviced by 
qualified service personnel when: 

A. The power-supply cord or the plug has been damaged; or 

B. Objects have fallen, or liquid has been spilled into the appliance; or 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

C. The appliance has been exposed to rain; or  

D. The appliance does not appear to operate normally or exhibits 

 a marked change in performance; or 

E. The appliance has been dropped, or the enclosure is damage 

15. Servicing - The user should not attempt any service to the appliance 
beyond that described in the operating instructions. All other servicing 
should be referred to qualified service personnel.\ 

16. Ventilation - Slots and openings in the cabinet are provided for 
ventilation and to ensure reliable operation of the product and to 
protect it from overheating, and these openings must not be blocked 
or covered. The openings should never be blocked by placing the 
product on a bed, sofa, rug, or other similar surface. This product 
should not be placed in a built-in installation such as a bookcase or 
rack unless proper ventilation in the manufacturer’s instructions have 
been adhered to. 

17. Attachments - Do not use attachments not recommended by the product 
manufacturer as they may cause hazards. 

18. Accessories - Do not place this product on an unstable cart, stand, 
tripod, bracket, or table. Do not place this product on an unstable cart, 
stand, tripod, bracket, or table. The product may fall, causing serious 
injury to a child or adult, and serious damage to the product. Use only 
with a cart, stand, tripod, bracket, or table recommended by the 
manufacturer, or sold with the product. Any mounting of the product 
should follow the manufacturer’s instructions, and should use 
amounting accessory recommended by the manufacturer. 

19. Replacement Parts - When replacement parts are required, be sure 
the service technician has used replacement parts specified by the 
manufacturer or have the same characteristics as the original part. 
Unauthorized substitutions may result in fire, electric shock, or other 
hazards. 

20. Safety Check - Upon completion of any service or repairs to this 
product, ask the service technician to perform safety checks to 
determine that the product is in proper operating condition. 

21. This product complies with EUWEEE regulations. Disposal of end of 
life product should not be treated as municipal waste. Please refer to 
your local regulations for instructions on proper disposal of this 
product. 

22. Carts and Stands - The appliance should be used only with a cart or 
stand that is recommended by the manufacturer. An appliance and 
cart combination should be moved with care. Quick stops, excessive 
force, and uneven surfaces may cause the appliance and cart 
combination to overturn. 

23. Warning - The mains plug is used as disconnect device, the 
disconnect device shall remain readily operable. 

24. This equipment is a Class II or double insulated electrical appliance. It 
has been designed in such a way that it does not require a safety 
connection to electrical earth. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IMPORTANT SAFETY PRECAUTIONS 

To reduce the risk of electric shock, do not remove any cover. 
No user-serviceable parts inside. Refer servicing to qualified service personnel only.

"dangerous voltage" within the product's enclosure that may be significant enough to constitute a risk of electric shock.

The exclamation point within the equilateral triangle is intended to alert the user to the presence of important operation and 

The lightning flash with arrowhead symbol within the equilateraltriangle is intended to alert the user to the presence if un-insulated

maintenance (servicing) instructions in the literature accompanying this appliance.

To prevent electric shock, do not use this polarized plug with an extension cord, receptacle or other outlet unless the blades can be fully
inserted to prevent blade exposure. 

To reduce the risk of electric shock, do not expose this apparatus to rain or moisture. Ensure that the apparatus is not exposed to splashing and that
no objects filled with liquids, such a vases, are placed on the apparatus.

            
DO NOT OPEN

RISK OF ELECTRIC SHOCK

CAUTION

WARNING

CAUTION

CAUTION:
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ASSEMBLY
 

CONNECTIONS
 

PLACEMENT
 

Ribbon tape
Driving roller
Drive belt

 Set the PH/LINE 
 switch to Line”

 Set the PH/LINE 
 switch to “PH”

 

 

 

 

Thank you for purchasing the T.55 USB turntable from Stanton. The T.55 USB is built upon Stanton’s heritage of designing audiophile products 
for the most discriminating listener. Before assembling the T.55 USB please check to make sure the following items are included with the main 
unit in the carton. 

 

� AC cord 

� RCA cable 

� 45 rpm adaptor 

� Counter weight 

� Cloth dust cover 

� Platter with belt (Belt is located underneath the platter) 

� Slipmat 

� Stanton 500.V3 Cartridge pre-mounted on headshell 

except on model T.55USBX, no cartridge included 

� Cakewalk Pyro Audio Creator LE 

� User Manual 

� Target light 

 

 

After confirming that all of the above parts are included in the box, its time to assemble the turntable. 

 1) Remove the platter from its protective wrapping and place on the spindle of the main unit. 

2) Loop the belt over the motor pulley. Be sure it does not twist. 
 

 

 

 

 

 

 

 

 

3) Remove the slipmat from its protective wrapping and place on the platter. 

4) Place the counter-weight on the back of the tonearm assembly. 

5) If desired, place the 45rpm adaptor in its allocated holder on the main unit. 

 

 

 

 

 

 

 
- Do not place the unit in a location where it will be exposed to direct sunlight or near a heating appliance. 
 
- Do not place the unit in a location where there is high humidity or a lot of dust. 
 
- Cartridge may pick up slight sound pressures or vibrations from the speakers coming along the floor or through the air resulting in feedback. Find a location 
which is very stable and vibration free. 

 

- The legs have functions for adjusting the height of the unit itself. Adjust the legs to stabilize the main body horizontally. 

 

 

 

 

 

 

 

 

 
Before connecting the unit it is advised that you also consult your current equipment instruction manual. 
 
Note: Be sure to turn off the equipment before you make changes to the different connections. 
 
1. Connect the power cord to an AC outlet. 
 
2. Connect the RCA cable to the PHONO input of your amplifier.  

Output terminals       Amplifier(Receiver) 
 L (White)   L Channel 
 R (Red)   R Channel 

You can also use a line input by setting the phono / line switch at the rear of the turntable 
  to line. 

3. Connect a PC via USB cable. 
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TONEARM AND CARTRIDGE SETTING

OPERATIONS
 

MAINTENANCE
 

The majou cause of problems with acoustic performance and skipping on the vinyl is the lack of proper set up of the needle and turntable adjustments.
The needle is designed to operate at a specific angle to the vinyl. The T.55 USB has several adjustments to correctly position the needle to the vinyl!

1. The first adjustment is the installation of the cartridge-headshell assembly into the tone arm tube lock. The 
T.55 USB includes a Stanton 500 V3 cartridge pre-mounted to the headshell. Holding the tone arm tube in one 
hand, insert the cartridge-headshell into the tube lock with the other hand. Turn the lock ring clockwise (when 
viewed from the rear) until the headshell is locked tightly into the tone arm. Remove the needle protector from 
the cartridge and place the needle on record. View the needle from the front and insure that the needle is
perpendicular to the record surface. If some adjustment is needed, simply loosen the lock ring and rotate the 
cartridge headshell until the needle is perpendicular to the record surface. Then re-tighten the lock ring. 

2. The second adjustment is the needle (or stylus) pressure. Start with the cartridge headshell
assembly mounted into the tone arm. Remove any needle protectors provided. With tone arm 
free, adjust the tone arm counterweight by rotating the rear section until the tone arm floats in a 
balanced condition above the record or mat. Do not allow the needle to drop onto the mat or the 
turntable platter during this adjustment. You might damage the needle tip. Now, carefully hold
the tone arm in one hand while rotating the numbered ring on the front of the counter-weight 
with the other hand to the “0” setting. Next, without touching the numbered ring, Rotate the rear 
counterweight until the desired needle pressure reading is next to the line on top of the tone
arm tube. The recommended stylus pressure for the Stanton 500 V3 cartridge is between two 
and five grams. 

1

2

Locking Ring

2.0 1.0

0

Rear Section

Numbered Ring

1. Rotate the power dial clockwise to turn on the power. The speed indicator and the strobe-illuminator will light up. 
2. Place a record on the slip mat, when playing a 45rpm record with a large center hole, place the 45-rpm adaptor on the center spindle.
3. Set the rotation speed (33/45) to match the record. 
4. Remove the stylus protector, release the arm clamp. 
5. Press the Start/Stop button, the turntable platter will start to rotate. 
6. Move the tonearm over the desired groove. 
7. When play is finished, move the tonearm to the arm rest, secure the tonearm with the arm clamp. 
8. Press the Start/Stop button to stop the platter rotating and rotate the power dial to turn off the power.

- For best results & proper care of your equipment use Stanton Vinyl Cleaner (VC-1) for your records and Stylus Cleaner Kit for styli (SC-4). 
- Clean the stylus periodically with a soft brush to prevent the accumulation of dust. 
- When the sound becomes distorted or noisy, check the stylus. If worn out, replace it with a new one. 
- Do not use any volatile materials such as alcohol, thinner, benzine, etc., as they may harm the paint and damage the housing.
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CONTROL OVERVIEW

 
1. Start/Stop - Press this button to start or stop the platter. 
 
2. Strobe dots - The dots around the edge of the platter are used in 
conjunction with the light located inside the motor On/Off switch. While 
the platter is in rotation, the dots help to indicate the speed of rotation. 
The speed is lower than the displayed speed (33,45) when the dots are 
flowing to the right. It is higher than the displayed speed (33,45) when 
the dots are flowing to the left. When the strobe is stopped, the platter 
is rotating at the displayed speed. 

 
3. Slipmat 
 
4. Center spindle 
 
5. Power on/off 

- On - Rotate right 
- Off - Rotate left 

Note: The Power ON/OFF terminates all audio from both RCA & USB 
outputs. 
 
6. Platter revolution speeds 

- 33 rpm  Press 33 
- 45 rpm  Press 45 

 
7. Target light - Insert target light to the deck and it will light up. 
 
8. Pitch slider - Use this to change the speed of the platter when the PITCH 
indicator is lit. 
 
9. Headshell locking nut - Attach headshell by inserting into the front end of 
the tone arm, then turn the locking nut clockwise with the head shell firmly 
held horizontally. 

10. Tonearm 
 
11. Tonearm clamp and rest - Use this rest for the tone arm and clamp it in 
position during transportation. 
 
12. Counterweight - Use this to balance the tonearm and to adjust the stylus 
pressure. 
 
13. 45rpm adapter holder - Place the attached 45rpm adapter here. 
 
14. Headshell & Cartridge holder - For preparing / storing a cartridge on a 
headshell when cleaning or troubleshooting. 
 
15. Output L&R - This is the standard analog output (RCA jacks) which can 
be connected either to a phono or line input on any DJ mixer, depending on 
the setting of the phono / line selector. 
 
16. Phono/Line switch - Switches the RCA output to either phono or line 
level. 
 
17. USB vinyl/USB switch - Used for bypassing the phono preamp from the 
turntable output when using the USB cable only. 
 
18. USB socket - Connect the USB cable (included) to this socket and to a 
USB connector on your computer. After connecting the turntable to your 
computer, you can record your vinyl to your hard disk using the included 
Cakewalk Pyro Audio Creator LE software. 
Note: maximum USB cable length is 3 meters. 
 
19. Power cord connector - Used to connect the supplied power cord. 
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CREATING A CD FROM AN LP 

AUDACITY SOFTWARE OVERVIEW          (for PC and MAC) 

The T.55 USB includes a USB computer interface and Cakewalk Pyro Audio Creator LE CD software for Windows. Macintosh users can download the 
free Audacity software for recording directly from the T.55 USB. By connecting the T.55 USB to your computer and using the correct software, you can 
custom CDs from your record albums. 

 

In addition to creating CDs, you can edit the LP tracks, clean up clicks and noise, and apply special audio effects if desired. You can even make 
custom mixes with one track crossfading to another. To take full advantage of these features, be sure to read the User Manual or Help files in the 
software. 

 

 

 

 
 

 

 
Audacity is free software, licensed under the General Public License (GPL). More information as well as open source code can be found on the web at 
http://audacity.sourceforge.net/ 

 

 

Set up procedure 

 
1. Start by connecting your T.55 USB to the computer using a USB cable (included). 
2. Download and install the audacity recording software by visiting http://audacity.sourceforge.net/. 
3. Open Audacity. 
4. Go to Edit then Preferences. 
5. Click Audio I/O tab 

 

6. Choose recording device USB Audio Codec from the drop down menu. 

7. Choose Channels (2 Stereo). 

6

6

8. Select the Software Playthrough (Play new track while recording it) option.
9. Click OK.  
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AUDACITY SOFTWARE OVERVIEW          (for PC and MAC) 

 

 
 

 

 

Recording & saving tracks 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. When you are ready to record, click the Red record button on the computer.
11. When you have finished the recording, click the Yellow stop button. Click the Green play button to playback your finished recording.

 

You can now click File and choose Export As AIFF  (Macintosh) or Wave (Windows) to save the recording. This will save the entire recording 
as one audio file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. If you want to record the entire side of an LP, or a continuous selection of songs, repeat steps 1-3 above. When you are finished, you will be
able to see each song as a waveform, with silence in-betwen each song. If you stop the recording and then start again, the new recording will
appear as new audio tracks below the previous recording.
 
If you want to separate the recorded audio into different tracks, drag the cursor over a song segment in the waveform window to high light it, and
then from the File menu select Export Selection As AIFF  (Macintosh) or Wave (Windows). If you want to save it as an MP3 file, then choose
Export Selection As MP3. Give the file a name when prompted. Repeat for each song segment. 

13. You can remove silences at the start or end of the recording by draging the cursor over the silent region and then choosing Delete or Cut from
the Edit windows. 

14. For a Macintosh, after you have recorded your track, burn them to a CD using the Mac OS X finder, or with other Macintosh CD creation
programs. 

   For Windows, use Windows Explorer or another Windows CD creation program to burn a CD.  
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CAKEWALK PYRO AUDIO CREATOR LE OVERVIEW  (PC Users) 

1

2

To start, insert your complimentary Cakewalk Pyro Audio Creator LE CD into your disc drive on your computer and follow the installation instructions to 
completely install the software on your operating system. Complete instructions on how to use all the features of the software are included in the Help 
Menu. To transfer and record LPs to your hard drive from your T.55 USB, start by connecting your T.55 USB to your computer using the included USB 
cable. 

Launch the Cakewalk Pyro Audio Creator LE application via the start menu. The Audio Creator 
Toolbar will now be available for use.

1. Click the Options button at the top of the toolbar. This will allow you to select the T.55 USB as the 
USB audio input. This will bring up the screen shown below.

For Playback Device, select your soundcard. For Recording Device, select:
Stereo USB Audio CODEC.- After selecting this output you may monitor the recording via the RCA output on the T.55 USB.   

The sampling rate for CD’s is 44,100 Hz, so it is best to choose this rate in the Sample Rate selection. The Driver Mode menu is used to select the driver 
(ASIO, MME or WDM) that you are using for your soundcard, (for the T.55 USB, “MME (32-Bit) is suggested).  Latency refers to how fast the software 
responds to commands. Higher latency values are safer when recording and playing back audio. Iif audio clicks or pops are heard when recording or 
playing back recordings, it is suggested to raise this setting. When you have completed choosing your settings, press OK to close the Options Window. 
These settings will be saved and should not need to be edited again.

Operating System
Processor Speed  Intel® Pentium® 4 1.3 GHz, 

or AMD Athlon™ XP 1500+ or higher 

Windows XP
Intel® Pentium® 4 2.8 GHz [EM64T] or AMD Athlon™ 
64 2800+ or higher 

RAM
Hard Disk Space  50 MB for core program 

Windows XP/Vista/Vista x64

1 GB for program and content  
 256 MB 1 GB or higher

Video resolution  1024 X 768, 16-bit color 1280 X 960, 32-bit color 
Hard Disk Type
Audio Interface  Windows-compatible WDM- or ASIO-compatible, including Wave RT for 

Vista 
Optical Drive 

Any EIDE / Ultra DMA (7200 RPM) or SATA

CD-ROM required for installation / CD-R 
or CD-RW capability required for CD 
audio disc burning 

 

The T.55 USB comes with a complimentary CD with Cakewalk Pyro Audio Creator LE. Cakewalk Pyro Audio Creator LE allows you to create CD’s
directly from audio recorded from the T.55 USB to a Windows-based PC. The system requirements for Pyro Audio Creator LE are below:

System Requirements Requirements Minimum Recommended 
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2. Press the EDITOR button on the toolbar to bring up the editing window. This is where you will record and edit your audio files. After pressing the
EDITOR button, the screen below will appear.

3. Press the (3) Input Monitoring button. This will allow you to listen to the audio as you record it from the T.55 USB.

 

4. Press the red (4) Record button. This will also light up the (5) Pause button. Play a record on your turntable and you will see the meters at the
right of window show you the recording level. Now you are ready to record your record album. 

5. Press the Pause button and Audio Creator will start recording. Then, start playing your record. It is suggested to let the entire side of the record
play even if there are multiple tracks. When you are done recording the tracks you want, press the Stop button. The Editor screen will now display
the audio waveform.

9 

RECORDING AUDIO FROM A RECORD
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EDITING THE AUDIO 

 
Now you are ready to trim any unwanted audio (such as the silence between songs). Trimming will also separate the songs to create new “Clips.”  It is easy to 
see the separation between songs. This is where the volume of the waveform is at a low-level. If there is only a short space between songs, then it might not be 
quite as easy to see. The screen below shows the relative area where the tracks change. 

10 
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6. To make it easier to split up tracks or delete unwanted silence between songs, left-click the mouse and drag it over the areas between the songs. Press the 
(6) Zoom Selection button and the screen now zooms into the area between the songs. 

7. You can place the playback cursor at the start of each song and then press the (7) Split button to create a new Clip, or you can use the mouse highlight a 
Larger area to delete unwanted silence, and then press Delete on your keyboard. This will delete the unwanted audio and create a new Clip. Continue doing 
This or each song to create new Clips. You can also delete the audio at the start of the record and at the end. Now you’re ready to create Markers that will be 
Used to define Clips as CD or MP3 tracks. 
 
8. There are two ways to create Markers. The first is to place the Playback cursor at the start of each Clip and press the (8) Insert Marker button. You can also 
automatically create Markers at the start of each Clip. Under the Edit Menu, select the “Insert Markers at Clip Start.” This will create markers for every Clip. 

6 7 8

7. You can place the playback cursor at the start of each song and then press the (7) Split button to create a new Clip,. or you can use the mouse 
highlight a larger area to delete unwanted silence, and then press Delete on your keyboard. This will delete the unwanted audio and create a new Clip. 
Continue doing this for each song to create new Clips. You can also delete the audio at the start of the record and at the end. Now you’re ready to create 
Markers that will be used to defi ne Clips as CD or MP3 tracks.

8. There are two ways to create Markers. The fi rst is to place the Playback cursor at the start of each Clip and press the (8) Insert Marker button. You 
can also automatically create Markers at the start of each Clip. Under the Edit Menu, select the “Insert Markers at Clip Start”. This will create markers for 
every Clip.
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The next step is to name the Markers with the song names. Markers are indicated with a triangle. 
 

 
 
 
Place the cursor over a Marker and right-click the mouse. That displays the Marker naming window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the name of the song and press OK. Continue doing this for each Marker. Now you are ready to process the audio. 
 
PROCESSING CLIPS 
 
Audio Creator LE allows you to process your audio clips. The two most common processing functions are Normalizing and Audio Restore. Normalizing raises the 
level of your audio clip to a maximum user defined level that will make the Clip louder on playback. Audio Restore is used to remove pops and clicks and eliminate 
background noise. 
 
Normalizing a Clip 
 
Normalizing a Clip raises its audio level to maximum loudness or close to that. The pictures below show a Clip before normalizing it and after normalizing it. 
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9 10

9. To normalize a Clip, fi rst press the (9) Clip Select button. Then, place the cursor over a Clip and click to select it.

10. Next, press the (10) Normalize button. This brings up the Normalize window, as shown below.

Clip before normalizing Clip after normalizing
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It is usually best not to normalize to 100%. Instead, choose -0.5 dB or -1 dB. Set the normalization level to your desired amount and then press OK. 
 
Using the Audio Restore Plug-in 
  
Audio Creator LE includes an audio plug-in that helps eliminate noise, clicks and pops from a record. The plug-in is called Audio Restore by iZotope. 
 
To select the Audio Restore Plug-in from Cakewalk, right-click on the clip you wish to process. Then, select Process Clip Effect, then Cakewalk, and 
then Audio Restore. This will look like the picture below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This will display the Audio Restore window. 
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In this window, you can select the following options: 
 

- DeNoiser-This will help eliminate record background noise. 
- Declipper-This will eliminate parts of the audio where clipping occurs. Clipping happens when the recorded audio exceeds maximum level. 
- DeClicker-This will remove clicks or pops from the audio file. 

 
It is best to try the default settings first. The Train button is useful for “training” the Audio Restore plug-in to recognize what you consider background noise. 
Make your settings and press OK. If the result is not what you were expecting, you can select Undo (Control-Z) and try different settings. In the example below, 
there was a click in the audio from the record. Audio Restore removed the click. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                Before Audio Restore                       After Audio Restore 

 
 
Creating Audio CD’s 
 
Creating an Audio CD will allow you to playback your recording on any standard CD player. Unlike data CDs, audio CDs do not allow you to fit as many songs on 
the disc but ensure compatibility with older CD players. 
 
1) After you have edited and processed the audio, you are ready to create an Audio CD. First, make sure no Clips are selected. To do this, Press the Select Time 
button (to the right of the Select Clip button). Then, click anywhere in the edit window to de-select a clip. 
 
2) Under the File menu, select Save As, then choose the WAV option. This will display the following window 
 
 
 
 
 
 
 
 

Click in
Audio
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3) Click the “Use Markers as Track Indicators” checkbox to select it. This will automatically save each track and give it the same name as the Markers 
that you named. 

4) Then, click the “Add to Audio CD Track List” checkbox. This will automatically add all the tracks to the CD track list, making it easy to make a CD after 
saving the tracks. 

5) Press the Save button, and all your tracks will be saved with the correct names. 

6) Bring the Audio Creator Toolbar to the front and click on the BURNER button. This brings up the window below:

7) The CD tracks will already be in the list. You can add more tracks by pressing the Add Tracks button. Press the OPTIONS button to set the speed for 
CD burning. Finally, press the BURN CD button and your audio CD will be created.

Creating MP3 CD’s

MP3 CD’s are useful for CD players that support reading data CD’s as opposed to audio CD’s. By burning a CD with MP3s you can fit significantly more 
songs on the disc, but risk not being able to play the CD back in older CD players.

1) If you want to save your audio clips as MP3 files, under the File menu select Save As and then choose MP3. This brings up the following screen:

16 
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2) Click the “Use Markers as Track Indicators” checkbox to select it. This will automatically save each track as an MP3 file and give it the same name as the 
Markers that you named. Press the Save button, and the following screen is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3) First, select the bit rate for the MP3 files. Higher bit rates yield better quality. Set the Stereo Mode to Stereo. Variable Bit Rate Encoding sometimes yields better 
results, but may not be good if you are posting the files on the internet. The High-Pass Filter and Low-Pass Filter remove the highest and lowest frequencies. For 
best audio quality, do not select these features. The Quality slider determines how in-depth the MP3 encoder examines the file prior to encoding. 
 
The ID3 Info section allows you to write information about the MP3 tracks. If you have selected the Markers as Track Indicators feature, then the saved file name 
will be the same as the Track marker name. You can add in the name of the band, the album name, song title and other information here. That information will be 
written for all the saved tracks. Press the OK button to save the files. As each clip is saved, this dialog box appears so that ID3 tags can be changed if you wish. 
Now are you are ready to create an MP3 CD. 
 
After you have written the MP3 files, the TAGGER module on the Audio Creator Toolbar can be used to edit tags. 
 
4) To create an MP3 CD, bring the Audio Creator Toolbar to the front and click on the BURNER button. Select the Data CD Burner tab. It brings up the following 
window: 
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Press the Add File button to select the MP3 tracks you wish to write to CD. If you have files for one artist placed in a folder, press the Add Folder button to add an 
entire folder. When you have all the MP3 tracks selected, press the BURN CD button and the CD will be created. 
 
Congratulations! You have successfully digitized your 1st vinyl record!  Feel free to experiment with the other features of Pyro Audio Creator LE. The online Help 
screens offer help about the various functions. You can find further help for all Stanton products online. The Stanton FAQ can be found at: 
http://www.stantondj.com/v2/spt_faq.asp 
 
The Stanton Knowledge Base can be found at: http://www.stantondj.com/activekb/ 
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SPECIFICATIONS 
 
 

 
General Model: T.55 USB 

Dimensions 452(W) x 370(D) x 87(H)mm  

Weight 5.4Kgs  
Power supply AC 100V, 50/60Hz (For Japan)  

 AC 110V, 60Hz (For Taiwan) 
 AC 120V, 60Hz (For U.S.A., Canada, Mexico)  

 AC 220V, 50Hz (For United Arab Emirates, Chile, Argentina)  
 AC 220V, 60Hz (For Philippines)  
 AC 230V, 50Hz (For Europe, New Zealand, South Africa, Singapore, Israel)  

 AC 240V, 50Hz (For Australia, U.K.)  
Power consumption 6.5W 

 
Turntable Section  

Type 2-speed full manual 

Motor DC motor 
Driving Method Belt drive 

Speeds 33
1
/3 and 45rpm 

Wow and Flutter Less than 0.2% WRMS (JIS WTD) with 33
1
/3rpm 

S/N Ratio More than 50dB (DIN-B) 
Pitch Controls +/-10% 
Start Time Less than 1 sec. with 33

1
/3rpm 

Braking Time Less than 1 sec. with 33
1
/3rpm 

Time for Speed Change Less than 1 sec. from 33
1
/3 to 45 rpm. 

 Less than 1 sec. from 45 to 33
1
/3 rpm. 

USB Function USB Rec./Play Function 
A/D,D/A 16bit 44.1KHz or 48KHz USB Selectable 

  Computer interface USB 1.1 Compliant windows XP or MAC OS X 

 
Tonearm Section  

Type Static balanced straight shaped tonearm with cardan’s suspension 

Effective Arm Length 191mm 

Tracking Force Adjustment Range 0~4g 
Applicable Cartridge Weight 5.5g 

Needle Pressure Range 2~5g 
  

 
Audio Section  

Phono Output 2.5~5.0 mV at 1KHz 5cm/sec (HP-4005) 

Frequency Response 20Hz-20KHz  +1/-3dB 
Channel Separation More than 14dB 

Phono 
 
 
 Channel Balance Within 2.5dB at 1KHz 

Line Output 45~90 mV at 1KHz 5cm/sec (HP-4005) Line 
 Frequency Response 20Hz-20KHz/RIAA filter +1/-3dB (IN:1KHz/4mV) 
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Warranty 

Through Stanton’s authorized dealers around the World, Stanton, or one of Stanton’s authorized distributors outside the U.S., will, without charge, repair or 
replace, at the sole discretion of the entity responsible for making the repair or providing the replacement, any Stanton merchandise proved defective in 
material or workmanship for a period of one year following the date of original purchase. Exceptions to this warranty are as noted below: 

The warranty for mechanical parts which are subject to wear and tear are limited to the earlier of either thirty (30) days following the date of original purchase 
or the following number of cycles: Faders - 15,000; Rotary potentiometers - 10,000; and Switches - 10,000. 

Stanton will warrant all replacement parts and repairs for ninety (90) days from the date of original shipment. Repairs made necessary by reason of misuse, 
alteration, normal wear, or accident are not covered under this warranty. 

Returns 

Authorized Stanton dealers are only authorized to sell and distribute merchandise within a specific country. All goods requiring warranty repair or replacement 
must be returned (freight prepaid if not hand-delivered) to the authorized Stanton dealer from whom the merchandise was purchased and in the same country 
where the merchandise was purchased. For purposes of purchases made via the Internet, the merchandise must be returned to the authorized Stanton 
dealer in the country where the authorized Stanton dealer which sold the merchandise to purchaser is located and not the authorized Stanton dealer in the 
country where the purchaser is located or the country in which the merchandise was received. Any returns to a non-authorized dealer or to an authorized 
Stanton dealer not in the same country as the merchandise was intended to be sold or as set forth above will void this warranty.

To initiate a warranty repair, you must contact the authorized Stanton dealer from whom you purchased the merchandise, and follow such authorized Stanton 
dealer’s return policy. 

Stanton assumes no risk and shall be subject to no liability for damages or loss resulting from the specific use or application made of the merchandise. 
Stanton’s liability for any claim, whether based on breach of contract, negligence, infringement of any rights of any party, or product liability, and relating to the 
merchandise shall not exceed the price received by Stanton from your purchase of such merchandise. In no event will Stanton be liable for any special, incidental or 
consequential damages (including loss of use, loss of profit and claims of third parties) however caused, whether by the negligence of Stanton or otherwise. 
To the extent permitted by law and except as otherwise provided above, Stanton disclaims any express or implied warranties of merchantability or fitness 
for a particular purpose. 

The above warranty provides you with specific legal rights. You may also have additional rights, which are subject to variation from state to state and country to 
country. 

If there is a dispute regarding the warranty of merchandise that does not fall under the warranty conditions stated above, please include a written explanation 
with the merchandise when returned pursuant to the terms and conditions set forth herein. 

Please register your product online at www.stantondj.com 

Stanton Magnetics • 3000 SW 42nd Street • Hollywood FL 33312

Phone: +1 954.316.1500

Technical Support:
service@stantonmagnetics.com
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